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Welcome to ZoomText Fusion 10.1

ZoomText Fusion 10.1 is a powerful computer access solution for the visually-
impaired. Consisting of two adaptive technologies – screen magnification and
screen reading – ZoomText Fusion allows you to see and hear everything on the
computer screen, providing complete access to applications, documents, email
and the Internet. This quick reference guide provides helpful information on
installing and using the key features of ZoomText Fusion.

Note: This guide does not describe all of the features of ZoomText Fusion 10.1,
nor is it intended to replace the full documentation. For complete
information, refer to the ZoomText Fusion User's Guide or online help
system. To launch the online help system, select Help  ZoomText Help
in the ZoomText Fusion menu bar.
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System Requirements

To run ZoomText Fusion 10.1 you must have a system that includes the
following:

 Windows 7, 8.1, or 10
 Processor: 2 GHz single core or 1 GHz dual core
 Memory (RAM): 2 GB

o Recommended: 4 GB or higher
 Graphics card with support for DirectX 9.1 or above

o Recommended: DirectX 10 or later
o Recommended: 256 MB dedicated video memory

 Hard disk space: 800 MB for US English, 1 GB for international versions
 5-point multi-touch display required for ZoomText Fusion Touch Mode

support
 Sound card
 USB 2.0 (for future ZoomText Fusion Camera support)
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Installing ZoomText Fusion

When you insert the ZoomText Fusion DVD into your DVD-ROM drive, the
Setup program will start automatically. Follow the on-screen instructions to
complete the installation.

 If Setup does not start automatically

1. Press WINDOWS + R to open the Run dialog box.
2. Browse to your DVD-ROM drive.
3. Select the Setup program and click Open.
4. Click OK in the Run dialog box.

Uninstalling ZoomText Fusion

 To uninstall ZoomText Fusion in Windows 10

 In the Windows Start menu, choose All Apps  ZoomText 10.1 Other
 Uninstall ZoomText Fusion.

 To uninstall ZoomText Fusion in Windows 8.x

 On the Start Screen, type: Uninstall ZoomText Fusion. Choose the Uninstall
ZoomText Fusion item.

 To uninstall ZoomText Fusion in Windows 7

 In the Windows Start menu, choose Programs  ZoomText 10.1 Other
 Uninstall ZoomText Fusion.
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Starting ZoomText Fusion

Once ZoomText Fusion is installed on your system, it can be started using one
of the following procedures.

 To start ZoomText Fusion in Windows 10

 On the Windows desktop, click on the ZoomText Fusion 10.1 icon.
 In the Windows Start menu, choose All Apps  ZoomText Fusion 10.1 

ZoomText Fusion 10.1.

 To start ZoomText Fusion in Windows 8.x

 On the Start Screen, click on the ZoomText Fusion 10.1 tile.
 On the Windows desktop, click on the ZoomText Fusion 10.1 program

icon.
 On the Start Screen, type: ZoomText Fusion. Choose the ZoomText Fusion

10.1 item.

 To start ZoomText Fusion in Windows 7

 On the Windows desktop, click on the ZoomText Fusion 10.1 icon.
 In the Windows Start menu, choose Programs  ZoomText Fusion 10.1 

ZoomText Fusion 10.1.

When ZoomText Fusion starts up, it changes your display to show a magnified
view of the normal screen. As you move the mouse, type text and navigate your
applications, the magnified view automatically scrolls, keeping the area of
activity in view. ZoomText Fusion will also speak aloud, narrating your actions
as you work with your documents and applications.
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Setup Wizard

The Setup Wizard will run the very first time you launch ZoomText Fusion. The
Setup Wizard asks you a series of questions that allows you to set up your
magnification, speech, braille, and keyboard preferences without having to
manually do so. You will also be given the option to skip the Setup Wizard and
use the default settings. Click the Skip and Use Defaults button in the Setup
Wizard dialog box to do so.

Activating ZoomText Fusion

ZoomText Fusion 10.1 contains product activation technology designed to
eliminate unauthorized use of ZoomText Fusion, without imposing a burden on
legitimate users. Product activation is a simple, straightforward and
anonymous process that takes just a few seconds to complete when performed
over the Internet.

After you install ZoomText Fusion you have up to 60 days to activate the
software. Until you do, ZoomText Fusion will run as a trial. You can activate
immediately or anytime during the 60-day trial period. All features are
available during the trial period, so you have full use of the software. When the
trial period expires you must activate ZoomText Fusion to continue using it.

Preparing to Activate ZoomText Fusion
To activate ZoomText Fusion 10.1 you will need your ZoomText Fusion 10.1
serial number, provided with your purchased copy. If you have purchased an
upgrade version of ZoomText Fusion 10.1 you will also need the serial number
from your previous version of ZoomText (version 9.1 or earlier) unless your
previous version is already installed on your system. These serial numbers can
be found in the following locations of your ZoomText Fusion product packages:
on the ZoomText Fusion DVD sleeve, on the product registration card, on the
top of the ZoomText Fusion box, and on back of the ZoomText Fusion User’s
Guide.
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During the 60-day trial period, each time you start ZoomText Fusion the
Activation Wizard appears. The wizard presents the following options for you
to choose from:

 Option 1:   I have a serial number and want to activate ZoomText
Choose this option if you have already purchased or been provided with a
ZoomText Fusion product and you're ready to activate the software. The
wizard will guide you through the activation process.

 Option 2:   I want to purchase ZoomText
Choose this option if you are ready to purchase a ZoomText Fusion
product. The wizard will display information on how to purchase
ZoomText Fusion.

 Option 3:   I want to try ZoomText
Choose this option if you want to run ZoomText Fusion in trial mode.
Trial mode allows you to use ZoomText Fusion for up to 60 days. When
the 60-day trial period expires, you must activate ZoomText Fusion to
continue using it.

For complete information on activating ZoomText Fusion, see “Activating
ZoomText Fusion 10.1” in the ZoomText Fusion User's Guide or online help
system.
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Touch Screen Support

ZoomText Fusion 10.1 can be used on Windows 8.x and Windows 10 touch
screen devices including tablets, laptops and desktop monitors. ZoomText
Fusion follows along as you tap, drag and swipe your way through all of your
applications. ZoomText Fusion will not interfere with these gestures and will
respond to events produced by gestures the same way it responds to events
produced using the keyboard and mouse. You can also access ZoomText
Fusion’s user interface (toolbars, menus and dialogs) using the same standard
gestures that you are used to from other applications.

Using a standalone touch screen device requires the use of an on-screen
keyboard. When using a screen magnifier, the on-screen keyboard will not be
fully visible, forcing you to pan the magnified view in order to access all of the
keys. This will slow down your typing speed as well as your productivity
considerably. Therefore, we recommend connecting a physical keyboard when
you need to perform large amounts of typing.

Note: You must have a Windows 8.x or Windows 10 device that supports at
least five simultaneous touch points. These devices will display the
“Designed for Windows” logo.

ZoomText Fusion 10.1 provides a special ZoomText Fusion Touch Icon,
allowing you to instantly access key ZoomText Fusion features using touch
gestures. These features include zooming in and out, scrolling the magnified
view and using ZoomText Fusion’s reading tools like AppReader and the
SpeakIt Tool. Here’s how it works…

By default, when you install ZoomText Fusion 10.1 on a touch screen device, the
ZoomText Fusion Touch Icon will appear on an edge of the screen. This floating
icon remains visible even when you zoom in and out or scroll the magnified
view. You can move the icon to several anchor points along the edges of your
screen. This lets you position the icon exactly where you’d like it to be on
screen, and allows you to move it if the icon is covering an item you need to see.

The ZoomText Fusion Touch Icon has two modes of operation: Windows Touch
Mode and ZoomText Fusion Touch Mode.
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Windows Touch Mode passes all touch gestures to Windows and any other
applications that are open on the screen, just as if ZoomText Fusion was not
running on the system. This is the mode you need to be in when you want to
interact with your desktop or applications using touch gestures (including the
ZoomText Fusion toolbar). When in Windows Touch Mode, the icon appears as
a group of Windows 8.x Start Screen tiles with a pointing finger at the bottom.

ZoomText Fusion Touch Mode passes all touch gestures to ZoomText Fusion.
This is the mode you need to be in when you want to access the ZoomText
Fusion features that are supported by gestures (e.g. zoom in or out a little, or
pan the magnified view). When in ZoomText Fusion Touch Mode, the icon
appears as a ZoomText Fusion logo with a pointing finger at the bottom.

This icon will also pulse (fade in and out) to let you know that ZoomText
Fusion Touch Mode is active.

 To switch between Windows Touch Mode and ZoomText Fusion
Touch Mode

Double-tap the Touch Icon with one finger.

Tip! You can momentarily switch between touch modes by holding one
finger on the Touch Icon. When you move your finger off of the icon,
the previously active touch mode is automatically restored. This
means that when in Windows Touch Mode, you can momentarily
switch to ZoomText Fusion Touch Mode to pass a gesture to
ZoomText Fusion and then automatically return to Windows Touch
Mode (and vice versa).
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 To enable or disable the Touch Icon

In the Settings menu, choose Touch Screen Support  Enable Touch Icon
(or Disable Touch Icon).

 To adjust the size of the Touch Icon

In the Settings menu, choose Touch Screen Support  Touch Icon Size 
{size}.

 To select a color scheme for the Touch Icon

In the Settings menu, choose Touch Screen Support  Touch Icon Color 
{color}.

 To move the Touch Icon around the screen

Press and hold one finger on the icon and drag it to a desired location
anywhere along the edge of the screen.

 To display the ZoomText Fusion user interface

Double-tap with four fingers.

 To adjust the magnification level (zoom in and out)

Double-tap and hold three fingers, then drag up to zoom in or drag down to
zoom out.

 To pan the magnified view

Drag three fingers to move around the screen.

For complete information on using ZoomText Fusion’s Touch Screen Support,
refer to the ZoomText Fusion User's Guide or online help system.
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ZoomText Fusion User Interface

When you start ZoomText Fusion its user interface appears on the screen. This
window contains all of the menus and controls for operating ZoomText Fusion.
Features associated with magnification, speech, advanced screen reading and
productivity tools are grouped into separate toolbars and dialogs.

ZoomText Fusion button
Enables or disables ZoomText
Fusion.

Magnifier tab
Displays controls for ZoomText Fusion's magnification features.

Reader tab
Displays controls for ZoomText Fusion's screen reading features.

Minimize button
Hides the ZoomText Fusion user interface.

Tools tab
Displays controls for ZoomText Fusion's tools features.

Fusion tab
Displays controls for ZoomText Fusion's advanced screen reading features.
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The ZoomText Fusion user interface can be minimized (hidden) and restored
(made visible), without affecting the operation of ZoomText Fusion.

 To minimize ZoomText Fusion

Do one of the following:

 On the ZoomText Fusion title bar, click on the minimize button.
 While the ZoomText Fusion user interface is active, press ESC.

 To restore ZoomText Fusion

Do one of the following:

 Click on the ZoomText Fusion 10.1 button in the task bar.
 Press the Display User Interface hotkey: CTRL + SHIFT + U.
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Enabling and Disabling ZoomText Fusion

You can enable and disable ZoomText Fusion at any time, without exiting the
program. When disabled, ZoomText Fusion returns the screen to its normal
(unmagnified) state and all speech output is terminated.

 To enable ZoomText Fusion

Do one of the following:

 On the ZoomText Fusion user interface, click on the ZoomText Fusion
button.

 Press the Enable ZoomText Fusion hotkey: ALT + CAPS LOCK.

 To disable ZoomText Fusion

Do one of the following:

 On the ZoomText Fusion user interface, click on the ZoomText Fusion
button.

 Press the Disable ZoomText Fusion hotkey: ALT + DELETE.
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Magnifier Toolbar

The Magnifier toolbar provides quick access to ZoomText Fusion's
magnification features. Each toolbar button has an intuitive icon and label for
easy identification. Many of these buttons have pop-up menus that provide fast
access to the most important and frequently used settings. Related buttons are
grouped together and the group is labeled with a clickable link that opens their
associated dialog box. Features associated with this toolbar are described in
pages 14 through 31.

Icon

Group label

Icon label

Group
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Setting the Magnification Level

ZoomText Fusion provides a wide range of magnification levels, allowing you
to enlarge the view according to your needs. Magnification levels range from 1x
to 60x (1x to 8x in steps of 1, 10.1x to 16x in steps of 2, 20x to 36x in steps of 4,
42x to 60x in steps of 6, and fractional powers of 1.2x, 1.4x, 1.6x, 1.8x, 2.5x, 3.5x
and 4.5x).

 To adjust the magnification level

On the Magnifier toolbar, adjust the level in the Power spin box, or press
the Magnification hotkeys:

1x view (normal screen) 2x View 3x View

To… Press…

Increase magnification ALT + NUMPAD PLUS
Decrease magnification ALT + NUMPAD MINUS



ZoomText Fusion 10.1 Quick Reference Guide 15

Selecting a Zoom Window

ZoomText Fusion provides eight zoom window types: Full, Overlay, Lens, Line
and four Docked positions. Each of these windows offers a unique way of
viewing what is on the screen. At any time, you can switch zoom window types
to accommodate a different task or application environment.

 To select a zoom window type

On the Magnifier toolbar, select Type, and then select the desired
zoom window. You can also cycle through the zoom window types by
pressing the Zoom Window hotkey: CTRL + SHIFT + Z.
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Zoom Window Types

Full displays a magnified view that occupies the entire screen.

Overlay displays a magnified view that can be sized and moved to
occupy any portion of the screen.

Lens moves over the normal screen like a magnifying glass,
displaying what is directly beneath it. The lens automatically
follows as you move the mouse pointer, type text and navigate
your programs.

Line moves up and down the screen like a magnifying ruler,
displaying what is directly beneath it. The line window
automatically follows as you move the mouse pointer, type text and
navigate your programs.

Docked splits the screen in half, displaying a magnified 'docked'
view on one side and a normal (unmagnified) view on the other.
The magnified view can be docked against any edge of the screen:
top, bottom, left, or right.
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Adjusting a Zoom Window

ZoomText Fusion's windows can be sized and/or moved to occupy a different
portion of the screen (with the exception of Full zoom).

 To size and move a zoom window

1. On the Magnifier toolbar, choose Type  Adjust.
The Adjust tool becomes active and sizing handles appear on the
zoom window frame.

2. To size the window, drag any handle.
3. To move the window, drag inside the window frame.
4. To scroll the contents of the window, hold down CTRL, and then drag

inside the window frame.
5. To exit the Adjust tool, right-click or press ESC.
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Using the Freeze Window

In a magnified view, it is impossible to see the entire screen at once. As a result,
you may not be able to view multiple items of interest at the same time, such as
information located at opposite edges of the screen. The Freeze window allows
you to monitor a selected area of the screen while you simultaneously view and
work in other areas of the screen.

 To set up a Freeze window

1. Set the zoom window type to Full.
2. In the Magnifier toolbar, select Type  Freeze New.
3. Move the mouse pointer until the area you want to freeze is scrolled into

view.
4. Drag to select the freeze area.

The Freeze window appears with sizing handles on the frame.
5. To size the window, drag any handle. To move the window, drag inside

the window frame. To scroll the contents of the window, hold down
CTRL and drag inside the window frame.

6. To exit the Freeze tool, right-click or press ESC.

 To enable and disable the Freeze window

On the Magnifier toolbar, choose Type  Freeze  Enable (or Disable).
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Using View Mode

View mode shows you the area of the screen that’s currently being magnified,
and allows you to select a new area to zoom in on. When view mode is
activated, magnification turns off and the view locator appears in the normal
screen. By moving the view locator, you can select a new area to zoom in on.

 To use View Mode
1. In the Actions menu, choose View Mode.

Magnification is temporarily turned off and the view locator appears.
2. Move the view locator to the desired screen location.
3. Click to zoom-in on the new location.

Magnification is restored with the selected screen area displayed.

You can configure the view locator to appear in a variety of shapes and colors.

 To configure the view locator
1. In the Magnifier menu, choose View Locator…
2. Adjust the locator options as desired.
3. Click the OK button.
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Color Enhancements

Color enhancements improve clarity of text and graphics, providing easier
viewing and reduced eyestrain. The color enhancement options consist of a
variety of filter effects that adjust color, contrast and brightness. You can choose
from preset color schemes or configure your own custom color settings.

 To choose a preset color scheme

On the Magnifier toolbar, select Color Scheme, and then
select the desired color scheme.

 To configure custom color settings

1. In the Magnifier menu, choose Color Enhancements…
2. Select Custom…
3. Adjust the custom settings as desired.
4. Click the OK button.

Note: You can turn color enhancements on and off using the
Color Enhancements On/Off hotkey: CTRL + SHIFT + C.
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Pointer Enhancements

Pointer enhancements make it easy to locate and follow the mouse pointer. You
can adjust the size and color of the pointer, and activate a locator that
emphasizes the pointer’s position on the screen. You can choose from preset
pointer schemes or configure your own custom pointer settings.

 To choose a preset pointer scheme

On the Magnifier toolbar, select Pointer  Scheme, and then
select the desired pointer scheme.

 To configure custom pointer settings

1. In the Magnifier menu, choose Pointer Enhancements…
2. Select Custom…
3. Adjust the custom settings as desired.
4. Click the OK button.

Note: You can turn pointer enhancements on and off using the
Pointer Enhancements On/Off hotkey: CTRL + SHIFT + P.
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Cursor Enhancements

Cursor enhancements make it easy to locate and follow the text cursor. A choice
of high visibility locators marks the cursor’s position, without obscuring the
surrounding text. You can choose from preset cursor schemes or configure your
own custom cursor settings.

 To choose a preset cursor scheme

On the Magnifier toolbar, select Cursor  Scheme, and then
select the desired cursor scheme.

 To configure custom cursor settings

1. In the Magnifier menu, choose Cursor Enhancements…
2. Select Custom…
3. Adjust the custom settings as desired.
4. Click the OK button.

Note: You can turn cursor enhancements on and off using the
Cursor Enhancements On/Off hotkey: CTRL + SHIFT + R.
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Focus Enhancements

Focus enhancements make it easy to locate and follow the control focus when
you tab and arrow through menus, dialogs, toolbars, and other application
controls. When enabled a choice of high visibility locators mark the position of
the control with focus, without obscuring any surrounding text. You can choose
from preset focus schemes or configure your own custom focus settings.

 To choose a preset focus scheme

On the Magnifier toolbar, select Focus Scheme, and then
select the desired focus scheme.

 To configure custom focus settings

1. In the Magnifier menu, choose Focus Enhancements…
2. Select Custom…
3. Adjust the custom settings as desired.
4. Click the OK button.

Note: You can turn focus enhancements on and off using the
Focus Enhancements On/Off hotkey: CTRL + SHIFT + O.
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Font Enhancements

With conventional screen magnifiers, the clarity of fonts (text characters) is
degraded in the magnified view. As a result, many fonts are difficult to read,
including; small fonts, serif and italic fonts, and most cursive and ornate fonts.
These problems are eliminated with ZoomText Fusion's patented xFont text
enhancement technology. With xFont, all font types are magnified with perfect
clarity – at all magnification levels.

 To turn font enhancements on and off

Press the Font Enhancements hotkey: CTRL + SHIFT + F.

 To configure font enhancement options

1. In the Magnifier menu, choose Font Enhancements…
2. Adjust the font enhancement options as desired.
3. Click the OK button.
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Using the Desktop Finder

The Desktop Finder helps you find and open programs and documents located
in the Windows desktop environment - including the quick launch bar, system
tray and control panel. When executing the Desktop Finder, a dialog box
displays a list of items located in the desktop environment. This list can be
filtered and searched, allowing you to quickly locate the desired item. Desktop
Finder 'Actions' allow you to open the item or view its properties.

 To use the Desktop Finder

1. On the Magnifier toolbar, select Desktop.
The Desktop Finder dialog appears.

2. Filter and sort the Desktop Items list by selecting the desired options
under Show These Items and Sort Items By.

3. To narrow the search, type the information you are searching for in the
Search For combo box, or select a recent entry from the combo box list.

4. Select the desired item in the Desktop Items list.
5. Click the Open button to launch the selected item, or the Properties

button to view the properties for the selected item.
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Using the Web Finder

The Web Finder allows you to swiftly search, skim, navigate and read
webpages. You can search for words or phrases throughout an entire webpage
to find topics of interest. When you've found a topic of interest you can have
Web Finder start reading from that location (ZoomText Fusion
Magnifier/Reader only). Web Finder can also find and execute links and
controls allowing you to seamlessly navigate between webpages. All of these
actions are performed using Web Finder’s simple toolbar/dialog and keyboard
commands.

Web Finder provides two modes for searching webpages: Page Search and List
Search. These modes and how to switch between them are described in the
sections below.

Note: Web Finder can be used in popular web browsers including Internet
Explorer, Firefox, and Chrome.

 To use the Web Finder

1. On the Magnifier toolbar, select Web.
The Web Finder toolbar/dialog appears.
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 To use Page Search

1. If Web Finder is currently in List Search mode, click the List button to
switch to Page Search mode.

2. Select the type of Page Items that you want to search. Choose "All Text"
to search for words or phrases anywhere on the page.

3. In the Search box, type a word or phrase that you want to find.
If the word or phrase does not exist in the selected type of page item the Search box
will turn orange and the navigation buttons will be disabled (grayed out).

Note: When Page Items is set to "All Text", you must type at least one
character in the Search box to initiate a search.

4. Click the Next and Previous buttons to navigate forward and backward.
As you navigate each item is highlighted. When using ZoomText Fusion with
speech enabled, the sentence containing the item is announced.

5. To have Web Finder execute a link or control, click the Execute button.
6. To have Web Finder start reading at the current item, click the AppRdr

button. *
7. To exit Web Finder, click the Exit button.
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 To use List Search

1. If Web Finder is currently in Page Search mode, click the List button to
switch to List Search mode.

2. In the Page Items combo box, select the type of items that you want to
view in the Items found list.

3. To search (or filter) the list, type a word or phrase in the Search box.
As you type in the Search box the list is automatically filtered to display only items
that contain the search string. The Search box turns orange when the typed word
or phrase does not exist within the list of items.

4. Select the desired sorting order in the Sort by list box. You can also sort
the list by clicking on the Name and Type headings at the top of the list.

5. To have Web Finder start reading from the selected item (using
AppReader), click the AppRdr button. *

6. To have Web Finder execute a link or control, click the Execute button.
7. To have Web Finder go to the location of the selected item, click the

GoTo button.
8. To exit Web Finder, click the Exit button.
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Using the Text Finder

The Text Finder helps you locate words or phrases within the active application
window or the entire screen. After entering the text you want to search for, the
Text Finder highlights and reads each found occurrence of the text or the entire
line that contains the text.

 To use the Text Finder

1. On the Magnifier toolbar, select Text.
The Text Finder dialog appears. For information on this dialog, see “Text
Finder” in ZoomText Fusion’s user’s guide or online help system.

2. In the Search For box, type the word(s) you want to search for.
3. Select any other Text Finder options that you want to use.
4. Click the Search button.

The Text Finder dialog is hidden and the first occurrence of the search text
is highlighted and spoken according to the selected options. The Text Finder
toolbar appears above the found text, providing controls for navigating and
reading occurrences of the search text.

5. To navigate to the next or previous occurrence of the search text, use the
Text Finder toolbar or associated Text Finder commands.

6. To exit the Text Finder, right-click or press ESC.

The Text Finder toolbar appears above the found text, providing controls for
navigating and reading occurrences of the search text.

The Text Finder toolbar
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Read *   Reads the entire line that contains the found word.
Shortcut Key: ENTER
Previous Displays the previous occurrence of the search text.
Shortcut Key: LEFT or SHIFT + TAB
Next Displays the next occurrence of the search text.
Shortcut Key: RIGHT or TAB
Start AppReader *   Launches AppReader and begins reading from the
location of the highlighted search text. Shortcut Key: A or ALT + SHIFT + A
Settings Returns to the Text Finder dialog.
Shortcut Key: BACKSPACE
Close Exits the Text Finder.
Shortcut Key: ESC
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Smooth Panning

Smooth panning (patent pending) provides a more natural panning motion
when the magnified view scrolls to keep the focus in view. As you type text and
navigate menus, dialogs and other program controls the magnified view
smoothly pans across the screen, rather than jumping in an abrupt manner. You
can also use “smooth mouse panning” to smoothly pan and explore in any
direction.

Note: Smooth mouse panning is only available when the zoom window type
is set to Full.

 To enable and adjust smooth panning

1. In the Settings menu, choose Panning...
2. Make sure the Enable smooth panning box is checked.
3. Adjust the panning options as desired.
4. Click the OK button.

Note: You can turn smooth panning on and off using the
Smooth Panning On/Off hotkey: WINDOWS + SHIFT + P.
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Reader Toolbar

The Reader toolbar provides quick access to ZoomText Fusion's speech settings
and reading tools. Each toolbar button has an intuitive icon and label for quick
identification. Many of these buttons have pop-up menus that provide fast
access to the most important and frequently used settings. Related buttons are
grouped together and the group is labeled with a clickable link that opens their
associated dialog box. Features associated with this toolbar are described in
pages 33 through 52.

Icon

Group label

Icon label

Group
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Turning Speech On and Off

You can turn speech output on and off without disabling the magnification
features.

 To enable and disable speech

On the Reader toolbar, select Speech Enable (or Disable), or, press the
Speech On/Off hotkey: ALT + SHIFT + S

Note: AppReader, DocReader and the SpeakIt tool can be used when speech is
disabled.

There may be times when you want to terminate speech output while it is
occurring. For example, when ZoomText Fusion is reading a message box that
you are already familiar with. You can force ZoomText Fusion to stop speaking
this text without turning speech off altogether.

 To terminate speech output as it occurs

Press and release the CTRL key.
The information that is currently being spoken is terminated.
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Adjusting the Speech Rate

Speech rate allows you to control how fast ZoomText Fusion speaks in words
per minute (SAPI 4 synthesizers) or in percentage of the synthesizer's range
(SAPI 5 synthesizers).

 To adjust the speech rate

On the Reader toolbar, adjust the level in the Rate spin box,
or, use the Speech Rate hotkeys:

A separate speech rate is available for AppReader and DocReader. This setting
is located in the Reading Options dialog box. In the Reader menu, choose
Reader Options…

To… Press…

Increase speech rate CTRL + NUMPAD PLUS
Decrease speech rate CTRL + NUMPAD MINUS
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Synthesizer Settings

Synthesizer settings let you customize the screen reading voice. You can select
from a variety of male and female voices, and adjust their speaking rate, pitch
and volume.

Note: ZoomText Fusion comes with two speech synthesizers: Vocalizer
Expressive and NeoSpeech (English only). The ZoomText Fusion Setup
program will install both of these synthesizers automatically. ZoomText
Fusion also supports other SAPI 4 and 5 based synthesizers or hardware
devices that have been installed on your system.

 To adjust the speech synthesizer settings

1. In the Reader menu, choose Synthesizer…
2. The ZoomText Screen Reader dialog opens.
3. Choose a Synthesizer and Voice.
4. Navigate to Screen -> Voice, and adjust the rate, pitch and volume as

desired.
5. When satisfied with the changes, click the Close button.
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Typing Echo

Typing echo allows you to hear the keys and words that you type. You can
choose to have individual keys, words, or both keys and words spoken. Typed
words are spoken upon completion (as soon as you type a space or punctuation
character). Additional typing echo options also allow you to select which keys
are spoken – all keys or selected groups of keys.

 To enable typing echo

On the Reader toolbar, click Typing and then select the desired
typing echo mode.

 To adjust the typing echo options

1. In the Reader menu, choose Typing Echo…
2. The ZoomText Screen Reader dialog opens.
3. Adjust the typing echo options as desired.
4. Click the Close button.
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Mouse Echo

Mouse echo automatically reads text beneath the pointer. As you move the
pointer across the screen, single words or complete lines of text are echoed
instantly or after hovering briefly.

 To enable mouse echo

On the Reader toolbar, click Mouse and then select the desired
mouse echo mode.

 To adjust the mouse echo options

1. In the Reader menu, choose Mouse Echo…
2. The ZoomText Screen Reader dialog opens.
3. Adjust the mouse echo options as desired.
4. Click the Close button.
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Verbosity

Verbosity allows you to adjust the amount of information spoken about
program controls when they become active or highlighted. Program controls
include: application and document windows, menus, dialogs, buttons, icons,
and more.

Three verbosity levels – Beginner, Intermediate and Expert – allow you to
quickly increase or decrease the verbosity. Beginner verbosity provides more
information, while Expert verbosity provides less information. Each of these
verbosity levels can be fully customized according to your personal needs.

 To select a verbosity level

On the Reader toolbar, click Verbosity and then select the desired verbosity
level.

 To adjust the verbosity options

1. In the Reader menu, choose Verbosity…
2. The ZoomText Screen Reader dialog opens.
3. Adjust the verbosity options as desired.
4. Click the Close button.
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AppReader

AppReader reads documents, web pages and email, within the parent
application. As you enter and exit AppReader your view of the document does
not change, providing quick and seamless transitions between document
editing and reading.

AppReader can automatically read through the entire document, or you can
manually read by word, line, sentence or paragraph. As reading occurs, each
spoken word is highlighted. AppReader settings allow you to customize the
appearance of word highlighting, including the highlight shape, size, color, and
transparency level.

 To adjust the AppReader settings

1. In the Reader menu, choose AppReader…
2. Adjust the AppReader settings as desired.
3. Select the OK button.

AppReader highlighting
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 To start and operate AppReader

1. Open the document, web page or email that you wish to read.
2. Press the AppReader hotkey: ALT + SHIFT + A,

or, on ZoomText Fusion's Reader toolbar, click the AppRdr button.
AppReader begins reading from the current text cursor position.

Note: The AppReader button is disabled (grayed out) when the last active
application does not contain readable text.

3. To stop reading, press CTRL or click with the mouse.
When AppReader stops reading, the cursor is automatically positioned at the last
word that was highlighted in AppReader (if a cursor exists).
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Read from Pointer (AppReader)

The Read from Pointer command lets you instantly start AppReader at the
word under the mouse pointer, making use of AppReader fast and seamless in
documents, web pages and email.

 To use the Read from Pointer command

1. Position the mouse pointer over the word where you want AppReader to
start.

2. Press the Read from Pointer command: ALT + SHIFT + LEFT-CLICK.
AppReader starts up and begins reading at the word under the mouse
pointer.
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DocReader

DocReader reads documents, web pages, and email, in a special environment
where text is reformatted for easier viewing. Text is presented in a single line
(Ticker) or wrapped lines (Prompter), with your choice of fonts, colors, word
highlighting, and magnification level.

DocReader can automatically read through an entire document, or you can
manually read by word, line, sentence or paragraph. As reading occurs, each
spoken word is highlighted.

Ticker mode Prompter mode
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 To start and operate DocReader

1. Open the document, web page or email that you wish to read.
2. Press the DocReader hotkey: ALT + SHIFT + D, or,

on ZoomText Fusion's Reader toolbar, click the DocRdr button.
The DocReader screen appears with text from the source document.
If the source document contains an active text cursor, the word at the cursor
position is highlighted in the DocReader display. Otherwise, the first word in the
DocReader screen is highlighted.

Note: The DocReader button is disabled (grayed out) when the last active
application does not contain readable text.

3. To start and stop reading, click the Play button or press ENTER.
While paused, you can click any word to set a new location to read from.

4. To read manually, use the text reading commands
(see "Text Reading Commands" on page 51).

5. To exit DocReader, right-click or press ESC.
When DocReader exits, the text cursor is automatically positioned at the last
word that was highlighted in DocReader (if a cursor exists).
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The DocReader toolbar provides controls for operating DocReader and
accessing settings that modify the appearance of text and highlighting.

DocReader toolbar

Play/Pause Starts and stops reading at the highlighted word.
Rate Controls how fast DocReader speaks.
Power Sets the magnification level used by DocReader, from 1x to 36x.
Ticker Displays a single line of text that scrolls horizontally like a tickertape,

along with a 1x view of the source document that appears beneath.
Prompter Displays multiple wrapped lines of text that scroll vertically like

a teleprompter.
Settings Opens the Reading dialog box to change the DocReader settings.
Speech Opens the Speech dialog box to change the speech settings.
Exit Exits DocReader and activates the source application.
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Reading Zones

Reading zones let you instantly see and hear selected locations in an application
window. For example, your database application may display a dozen or more
fields of information. In your normal work flow you may be interested in only a
few of these fields. With reading zones, you can instantly see and/or hear these
select fields with the press of a hotkey.

You can create up to 10.1 reading zones per application. As you open and
switch between applications, the zones for the active application are
automatically loaded and ready to use.

The Reading Zones Toolbar

The Reading Zones toolbar appears over the active reading zone whenever you
access reading zones. The toolbar provides controls for navigating and reading
the defined zones.

Reading Zones toolbar - Edit and Navigate modes Reading Zones toolbar – Trigger
mode

Play/Pause/Stop Starts and stops reading. When Play mode is executed, the
Pause or Stop button appears on the toolbar (according to the mode that is
active). The Pause button appears in Trigger and Navigate modes where you
can pause and restart reading at the highlighted word. The Stop button
appears in Edit mode where reading always restarts at the first word in the
zone.
Shortcut Key: ENTER
Previous Activates the previous reading zone.
Shortcut Key: SHIFT + TAB
Next Activates the next reading zone.
Shortcut Key: TAB
Close Exits the Reading Zone mode.
Shortcut Key: ESC
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 To create a reading zone

1. Open the application in which you want to create reading zones. Make
sure the desired application tab, view or window is displayed.

2. On ZoomText Fusion’s Reader toolbar, select Zones New, or, press the
Reading Zones hotkey: CTRL + ALT + WIN + Z.

The New Zone Tool becomes active and all existing zones for the active
application are displayed.

3. Move the mouse pointer to scroll the new zone area into view.

4. Hold down the left button, drag the selection rectangle over the desired
zone area and release the button.

When you complete the drag (release the mouse button), the Reading Zones
dialog appears. This dialog allows you to name the zone and select zone options.
For complete information on this dialog, see “Reading Zones Settings” in
ZoomText Fusion’s user’s guide or online help system.

5. In the Zone Name box, type a descriptive name for the new zone.
When you navigate to the next dialog control, the new zone name will appear in
the Zones list.

6. Under Zone is relative to, select the zone's relative position within the
application window.

7. Under Zone Actions, select the desired options.
8. To test the new zone, click Trigger.

The Reading Zones dialog is temporarily hidden while the zone is displayed
and/or spoken according to the selected settings.

9. To create additional zones, click New Zone and repeat steps 4 through 9.
10.When you're done creating and editing zones, click the OK button.
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 To edit reading zones

1. Open the application that contains the zones you want to edit.
2. On ZoomText Fusion’s Reader toolbar, select Zones  Edit, or, press the

Edit Reading Zones hotkey: CTRL + ALT + WIN + E.
The Edit Zones Tool becomes active and all existing zones for the active
application are displayed. The Reading Zones toolbar appears over the active
zone.

3. Move the mouse pointer to scroll the desired zone into view, or click the
Next or Previous buttons on the Reading Zones toolbar.

4. Click inside the zone to activate the sizing handles and toolbar.
5. To size the zone, drag any handle.
6. To move the zone, drag inside the zone frame.
7. To test reading of the zone, click the Play button.
8. To move to another zone, press the number of the desired zone, or click

the Next or Previous buttons.
9. To edit another reading zone, repeat steps 4 through 8.
10.To exit the Edit Zones tool, right-click or press ESC.
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 To trigger a reading zone

1. Open the application that contains the zones you want to trigger.
2. On ZoomText Fusion’s Reader toolbar, select Zones  Trigger, then

select the desired reading zone.
The selected reading zone is displayed and/or spoken according to the
zone settings.

You can also trigger reading zones using the following methods:

 Press the List Reading Zones hotkey: CTRL + ALT + WIN + L, then
select the desired zone from the menu.

 Use the Reading Zone hotkeys:

To trigger… Press…

Trigger zone 1 … 10 CTRL + ALT + WIN + 1 … 0
Next reading zone CTRL + ALT + WIN + N
Previous reading zone CTRL + ALT + WIN + P
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 To navigate through all reading zones

1. Open the application that contains the zones you want to navigate.
2. On ZoomText Fusion’s Reader toolbar, select Zones Navigate, or press

the Navigate Reading Zones hotkey: CTRL + ALT + WIN + V.
Navigate Mode becomes active and the Reading Zones toolbar appears over the
first active zone. The zone name and number are spoken.

3. To start and stop reading of the zone, click the Play/Pause button.
Note: The Play/Pause button is disabled (grayed out) when navigating

to non-spoken zones.

4. To navigate to another zone, click the Next and Previous buttons.
5. To exit Navigate Mode, click the Exit button on the Navigate toolbar. You

can also exit by right-clicking or pressing ESC.
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SpeakIt Tool

The SpeakIt tool allows you to read selected areas of the screen by clicking or
dragging with the mouse. Any text that is visible on the screen can be spoken,
even if it is outside the active program.

Note: Text that appears in graphical images cannot be spoken.

 To use the SpeakIt tool

1. On the Reader toolbar, click the SpeakIt button, or, press the SpeakIt
Tool hotkey: ALT + SHIFT + I.

2. To speak a single word, click on the word.
3. To speak a block of text, drag to highlight the text.

Upon release of the mouse button, all highlighted text will be spoken.
4. To exit the SpeakIt tool, right-click or press ESC.
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Text Reading Commands

Text reading commands let you navigate and read while creating and editing
documents (by word, line, sentence or paragraph). When using these
commands, the text cursor moves in accordance with the command. For
example, when pressing the Say Next word command, the cursor moves to the
beginning of the next word and it is spoken. The following table lists the text
reading commands.

Note: Num Lock must be turned off when using ZoomText Fusion commands
that utilize the numeric keypad.

Text Reading Commands Keys

Say Previous Character LEFT

Say Current Character 1 NUMPAD 5

Say Next Character RIGHT

Say Previous Word CTRL + LEFT

Say Current Word 2 CTRL + NUMPAD 5

Say Next Word CTRL + RIGHT
Say Previous Sentence UNDEFINED

Say Current Sentence CTRL + ALT + NUMPAD 5
Say Next Sentence UNDEFINED

Say Previous Line 3 UP

Say Current Line SHIFT + NUMPAD 5

Say Next Line 3 DOWN

Say Previous Paragraph CTRL + UP
Say Current Paragraph CTRL + SHIFT + NUMPAD 5

Say Next Paragraph CTRL + DOWN
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1 Second press of the Say Current Character command speaks the character
phonetically ("Alpha, Bravo, Charlie…")

2 Repeated presses of the Say Current Word command operates as follows:

 First press:  speaks the word
 Second press:  spells the word
 Third press:  spells the word phonetically ("Alpha, Bravo,

Charlie…")
Note: Repeated presses must occur within two seconds.

3 This command reads the current word or entire line according to the
Program Echo setting When the text cursor moves into a new line.
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Fusion Toolbar

The Fusion toolbar provides quick access to ZoomText Fusion's advanced
screen reading features and instructional tools. Each toolbar button has an
intuitive icon and label for easy identification. Related buttons are grouped
together and the group is labeled with a clickable link that opens their
associated dialog box. Features associated with this toolbar are described in
pages 54 through 59.

Icon

Group label

Icon label

Group
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Advanced Screen Reader Settings

ZoomText Fusion is a flexible solution with a robust set of customizable screen
reader settings. The Screen Reader Settings dialog can be used to explore and
configure the available options.

 To open the Screen Reader Settings dialog

On the Fusion toolbar, click Settings or choose Verbosity… in the Fusion
menu.
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Browse Mode

Browse Mode is a feature that provides enhanced keyboard navigation for web
pages, PDF documents, PowerPoint presentations and other file types that are
presented in a web-style view.

 To adjust Browse Mode settings

On the Fusion toolbar, click BrowseMode or choose the Browse Mode pull
down in the Fusion menu.
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Page Navigation

The Page Navigation dialog lists the available links, frames, tables, headings,
lists, anchors, forms, controls, and landmarks that happen to be on the current
web page. It can also provide lists of available elements in Word documents,
Excel spreadsheets, PowerPoint presentations and PDFs.

 To open the Page Navigation dialog

On the Fusion toolbar, click PageNav or choose Verbosity… in the Fusion
menu. Pressing INSERT + F7 will also open the Page Navigation dialog.
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Tutor Mode

Tutor Mode provides spoken keyboard hints for interacting with common
Windows control, such as buttons, list views, radio buttons, edit boxes, etc.

 To adjust Tutor Mode settings

On the Fusion toolbar, click TutorMode or choose Tutor Mode… in the
Fusion menu.
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Learning Center

Learning Center is an instructional tool that provides access to self-paced
ZoomText Fusion tutorials. Learning Center tutorials are organized into the
following categories: Getting Started, Magnification, Speech, Computer Basics,
Browsing the Web and Microsoft Office.

 To open Learning Center

On the Fusion toolbar, click LearningCtr or choose Learning Center… in
the Fusion menu.
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Pronunciation

Speech synthesizers sometimes make pronunciation errors especially when
uniquely spelled proper nouns and acronyms are encountered. Through the use
of ZoomText Fusion’s pronunciation dictionary, these errors can be corrected.

 To open the Pronunciation dictionary

On the Fusion toolbar, click Pronunciation or choose Pronunciation… in
the Fusion menu.
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Tools Toolbar

The Tools toolbar provides quick access to ZoomText Fusion's tools features.
Each toolbar button has an intuitive icon and label for easy identification.
Related buttons are grouped together and the group is labeled with a clickable
link that opens their associated dialog box. Features associated with this toolbar
are described in pages 61 through 70.

Icon

Group label

Icon label

Group
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ZoomText Camera

The ZoomText Camera feature allows you to use any high-definition (HD)
webcam to magnify printed items and other objects right on your computer
screen—including bills, magazines, photographs, medicine labels, craft items
and more. Simple controls allow you to quickly zoom in and out and choose
between full and high contrast colors. You can also switch between Full and
Docked screen views which allow you to see the camera image and your
Windows desktop at the same time. And by utilizing affordable and readily
available HD webcams, the ZoomText Camera feature offers a portable and
affordable compliment or alternative to conventional CCTVs.

Full View Docked (Top) View
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Getting Started With ZoomText Camera

Before you can use the ZoomText Camera feature you must acquire a suitable
camera and camera stand, set up the camera in your work space and choose
your camera in the ZoomText Camera settings.

Acquiring a suitable camera and stand

To use the ZoomText Camera feature, you will need an HD webcam with
autofocus. For best quality, your webcam should deliver 10.180p video
resolution with automatic low-light correction. A USB 2.0 port is also required to
connect your webcam.

In addition to a camera, you will also need a camera stand that can securely
position the camera over the items you want to view. The stand should be
adjustable and stable.

Ai Squared offers high quality webcam and camera stand packages that are
flexible, portable and affordable. For more information on these packages, visit
the Ai Squared website at www.aisquared.com, or contact your Ai Squared
dealer.

Setting up your camera in your workspace

To achieve best performance and usability with the ZoomText Camera feature,
use the following guidelines when setting up your camera in your workspace:

 Position the camera as close as possible to your computer screen. This will
allow you to easily manipulate items under the camera while viewing the
image.

 Make sure there is sufficient lighting around the camera.
 Adjust the camera stand so that the camera is about 4 inches from the

target item.
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Selecting a camera (when more than one camera is present)

ZoomText Fusion automatically detects all webcams that are attached or built
into your system. If your computer has more than one webcam, you will need
to tell ZoomText Fusion which webcam you want it to use.

 To select a camera

1. In the Tools menu, choose Camera…
2. In the Active Camera list box, choose the camera you want to use.
3. Click the OK button.

Using ZoomText Camera

Use the following steps to start, configure and use ZoomText Camera.

 To start ZoomText Camera

1. On the Tools toolbar, click the Docked button.
The camera image appears in the top half of the screen while ZoomText Fusion's
magnified view of the desktop remains on the bottom half of the screen. The
ZoomText Camera toolbar appears in the bottom half.

2. If the Camera toolbar is not in view, press CTRL + WINDOWS + T to bring
the toolbar into view.

ZoomText Camera toolbar
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 To rotate the camera image

Place a document under the camera so that it is right-side up from your
perspective. If the document is not oriented right-side up on the screen, click
the Rotate button until the image appears right-side up.

 To zoom the image in and out

Click the Zoom + and Zoom - buttons to adjust the magnification to a
comfortable reading size.

 To adjust the image colors

1. Click the Color button.
2. Choose between Normal (full color) and a variety of high-contrast Two-

Color Schemes.

Note: You can toggle between Normal (full color) and the selected Two-
Color scheme using the Camera Two-Color On/Off hotkey:
ALT + WINDOWS + SPACEBAR.

 To adjust the camera clarity (Brightness/Contrast)

1. Click the Clarity button.
The Camera Clarity dialog appears.

2. Place a checkmark next to Enable brightness and contrast settings.
3. Move the Brightness and Contrast sliders to adjust the clarity.
4. Click the Reset button to return the Brightness and Contrast settings to

the camera's defaults.
5. Click the OK button.

Tip: Use the Brightness setting to eliminate glare spots that are appearing
in the image.

Note: This button will be disabled (grayed out) if the active camera does
not support adjustments to both brightness and contrast.



ZoomText Fusion 10.1 Quick Reference Guide 65

 To adjust the camera focus

1. Click the Focus button.
The Camera Focus dialog appears.

2. Place a checkmark next to Enable manual camera focus.
3. Move the Focus slider to adjust the image focus.
4. Click the OK button.

Note: This button will be disabled (grayed out) if the active camera does
not support autofocus.

 To move the docked view location

Click the Docked button. Each click cycles through the docked views in the
following (clockwise) order: Docked Top > Docked Right > Docked Bottom >
Docked Left.

 To switch between Full and Docked views

Do one of the following:

 From either Full or Docked view, press CTRL + WINDOWS + Z.
 From Docked View, on the ZoomText Camera toolbar click the Full

button.

 To exit the ZoomText Camera

Do one of the following:

 From Full view, press ESC.
 From Docked view, click the Exit button.
 From either Full or Docked view, press CTRL + WINDOWS + ENTER.

 To operate ZoomText Camera with hotkeys

All of ZoomText Camera settings can be adjusted and controlled using
hotkeys. See "ZoomText Camera Hotkeys" on page 82).
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Camera Video and System Performance

On older computers, when using ZoomText Camera you may experience slow
system and camera video performance when the camera is configured to run at
a higher resolution, particularly at camera resolutions of 1280 and above. To
resolve this problem, lower the camera resolution until your system and camera
video performance is at an acceptable level. The resolution setting for ZoomText
Camera is located in the Camera tab in ZoomText Fusion’s Tools dialog box. See
“ZoomText Camera Settings” below.

ZoomText Camera Settings

The ZoomText Camera settings allow you to configure and launch the
ZoomText Camera.

 To configure the ZoomText Camera settings

In the Tools menu, choose Camera...
The Tools dialog appears with the Camera tab displayed.
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ZoomText Recorder

ZoomText Recorder (currently unavailable) allows you to turn text from
documents, webpages, email or other sources into audio recordings that you
can listen to on your computer or transfer to your mobile device for listening to
on the go. You simply copy or select the text you want to record and start
ZoomText Recorder. With a few simple steps you give your recording a friendly
name, choose a destination to record to and click the record button. And each
recording is created using your choice of ZoomText Fusion voices or any other
voices available on your system. When choosing iTunes or Windows Media
Player as your destination your recordings are conveniently placed in a
"ZoomText Recorder" playlist. And when using iTunes your recordings can be
automatically synced when you plug in your iPod, iPhone or other iDevice.

Starting ZoomText Recorder

There are two ways to record text when starting ZoomText Recorder. ZoomText
Recorder can record text that you have copied to the Windows Clipboard or text
that you have selected in the active application.

 To record text from the Windows Clipboard

1. Select the text that you want to record and copy it to the
Windows Clipboard.

2. Use one of the following methods to start ZoomText Recorder:

 Press the Record Clipboard Text hotkey: CTRL + CAPS LOCK + C.

 On the Tools toolbar, select Recorder.
The ZoomText Recorder dialog appears.
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 To record text selected in the active application

1. Select the text you want to record.
2. Press the Record Selected Text hotkey: CTRL + CAPS LOCK + S.

The ZoomText Recorder dialog appears.

Completing the recording process

When you start ZoomText Recorder its dialog appears with the captured text
ready to record. All you have to do is choose the desired recording options and
select the Record Text button. A progress indicator appears during the
recording process to let you know that it is working. You can stay and watch
the progress indicator or switch to another application and make better use of
your time. A friendly chime will sound when the recording process is complete.

Recording times vary depending on the size of the text selection, chosen
synthesizer, destination and speed of the system. However, our general rule of
thumb for recording time is about 5 to 10.1 seconds per page of text.

Note: When "Record text to:" is set to iTunes the iTunes application will open
at the end of the recording process.
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Background Reader

Background Reader (currently unavailable) allows you to listen to documents,
webpages, email or any text while you simultaneously perform other tasks. You
simply copy or select the text you want to listen to and start Background
Reader. While the text is being read aloud, you are free to type notes, browse
the web or do other work on your computer.

Starting Background Reader

There are two ways to capture text when starting Background Reader.
Background Reader can read text that you have copied to the Windows
Clipboard or text that you have selected in the active application.

 To read text from the Windows Clipboard

1. Select the text that you want to listen to and copy it to the Windows
Clipboard.

2. Use one of the following methods to start Background Reader:

 Press the Read Clipboard Text hotkey: CAPS LOCK + C.

 On the Tools toolbar, select BgRdr.
The Background Reader toolbar appears and automatically starts reading the
text you placed in the Windows Clipboard.
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 To read text selected in the active application

1. Select the text you want to listen to.
2. Press the Read Selected Text hotkey: CAPS LOCK + S.

The Background Reader toolbar appears and automatically starts reading
the text you selected in the active application.

Note: If the toolbar does not appear when starting Background Reader the
"Start toolbar minimized" option has been selected in the
Background Reader settings. To access and disable this setting, in
the Tools menu, choose Background Reader…

Operating Background Reader

Once you have started Background Reader you can operate it using the toolbar
or the hotkeys. The toolbar is an easy way to get started and learn how
Background Reader works. However, we highly recommend learning to use the
hotkeys as they will allow you to seamlessly control Background Reader while
you are working in other applications (without having to switch back and forth)
and realize the true multitasking potential of Background Reader.

 To operate Background Reader using the toolbar

1. To start and stop reading, click the Play/Pause button.
2. To skim forward and backward, click the Sentence and Word buttons.
3. To restart reading at the beginning, click the Restart button.
4. To read new text that you have placed in the Windows Clipboard, click

the Capture button.
5. To exit Background Reader, click the Exit button.

 To bring the Background Reader toolbar into view

When Background Reader is running you can bring its toolbar into view by
pressing CAPS LOCK + T.

 To operate Background Reader using hotkeys

Background Reader can be fully operated using the Background Reader
hotkeys. See "Background Reader Hotkeys" on page 81).
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Hotkeys

Hotkeys are key combinations that execute ZoomText Fusion commands
without having to activate the ZoomText Fusion interface. Hotkeys exist for
almost all ZoomText Fusion features, allowing you to control ZoomText Fusion
while another application is active.

Some important facts about ZoomText Fusion hotkeys are:

 Hotkeys can be changed or disabled to eliminate conflicts with other
programs.

 Both keys and mouse buttons can be used to define a hotkey.
 Each hotkey must be unique.

Each hotkey consists of one or more modifier keys and a single primary key.
The modifier keys consist of any combination of ALT, CTRL, SHIFT, CAPS LOCK
INSERT, and the WINDOWS key. The primary key can be any other key or any
mouse button.

 To change hotkey settings

1. In the Settings menu, choose Hotkeys…
2. The ZoomText Screen Reading dialog opens.
3. Select the desired Hotkey Group and Hotkey Command.
4. Adjust the hotkey combination as desired using the Capture Key button.
5. Repeat steps 3 and 4 for each hotkey you wish to modify.
6. Click the Close button.
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Browse Mode Hotkeys

Commands Keys

Anchor Next A

Anchor Prior SHIFT + A

Auto Load INSERT + A

Block Quote Next Q

Block Quote Prior SHIFT + Q

Browse Mode INSERT + Z

Button Next B

Button Prior SHIFT + B

Check Box Next X

Check Box Prior SHIFT + X

Combo Box Next C

Combo Box Prior SHIFT + C

Control Next F

Control Prior SHIFT + F

Different Line Next D

Different Line Prior SHIFT + D

Edit Next E

Edit Prior SHIFT + E

Element Properties INSERT + L
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Browse Mode Hotkeys (continued)
Commands Keys

Form Interaction CTRL + SLASH

Frame Next M

Frame Prior SHIFT + M

Graphic Next G

Graphic Prior SHIFT + G

Heading Next H

Heading Prior SHIFT + H

Landmark Next ;

Landmark Prior SHIFT + ;

Link Next L

Link Prior SHIFT + L

List Next S

List Prior SHIFT + S

List Item Next I

List Item Prior SHIFT + I

Page Navigation INSERT + F7

Paragraph Next P

Paragraph Prior SHIFT + P

Place Marker Dialog CTRL + SHIFT + K

Place Marker Next K

Place Marker Prior SHIFT + K
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Browse Mode Hotkeys (continued)
Place Marker, Jump To J

Radio Button Next R

Radio Button Prior SHIFT + R

Select Content F8

Specified Control Next SLASH

Specified Control Prior SHIFT + SLASH

Text Next N

Text Prior SHIFT + N

Visited Link Next V

Visited Link Prior SHIFT + V

Table Next T

Table Prior SHIFT + T

Cell Right INSERT + WINDOWS + RIGHT ARROW

Cell Left INSERT + WINDOWS + LEFT ARROW

Cell Up INSERT + WINDOWS + UP ARROW

Cell Down INSERT + WINDOWS + DOWN ARROW

End of Row CTRL + INSERT + WINDOWS + RIGHT ARROW

Beginning of Row CTRL + INSERT + WINDOWS + LEFT ARROW

Top of Column CTRL + INSERT + WINDOWS + UP ARROW

Bottom of Column CTRL + INSERT + WINDOWS + DOWN ARROW

Header Rotor CTRL + SHIFT + H

Web Application Mode CTRL + INSERT + A
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Cursor Hotkeys

Commands Keys

Character NUMPAD 5

Word CTRL + NUMPAD 5

Line SHIFT + NUMPAD 5

Sentence CTRL + ALT + NUMPAD 5

Paragraph CTRL + SHIFT + NUMPAD 5

Unicode/Attribute INSERT + F

Position CTRL + WINDOWS + NUMPAD PLUS

Miscellaneous Hotkeys

Commands Keys

Read Active Window INSERT + B

Speak Summary INSERT + TAB

Title/Status of Current Program INSERT + T

Progress Or Scroll Bar CTRL + INSERT + B

Status Line INSERT + NUMPAD 2

Last Flash and Tooltip CTRL + INSERT + T

Highlighted Block SHIFT + INSERT + NUMPAD 2

Read To End INSERT + NUMPAD DOWN 2

Key Describer INSERT + 1

Program Help INSERT + F1

Time/Date INSERT + F12

Battery Level INSERT + Q
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Miscellaneous Hotkeys (continued)
Wireless Status INSERT + W

Sys Tray INSERT + F11

Default Button INSERT + E

Verbosity Dialog INSERT + V

Menu ALT + SHIFT + U

Edit Dictionaries INSERT + D

Bypass INSERT + 3

Voice Down CTRL + NUMPAD MINUS

Voice Up CTRL + NUMPAD PLUS

Voice Selection Rotor ALT + SHIFT + RIGHT ARROW

Voice Parameter Rotor ALT + SHIFT + LEFT ARROW

Numbers Rotor INSERT + 6

Keyboard Voice Rotor ALT + SHIFT + T

Capitalization Alert Rotor INSERT + 4

Format Alert Toggle INSERT + 5

Auto Label Graphics INSERT + G

Label Field Name CTRL + INSERT + TAB

Speak All Toggle INSERT + S

Toggle All Voices (global) ALT + SHIFT + S

Autodetect Cursor CTRL + ALT + SHIFT + D

Reclass ALT + INSERT + R

Redraw INSERT + BACKSLASH
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Miscellaneous Hotkeys (continued)
Shutdown ZoomText Fusion INSERT + F4

Dump OSM CTRL + SHIFT + INSERT + D

Capture ZoomText Fusion Screen CTRL + ALT + SHIFT + C

Locator On/Off CTRL + SHIFT + L

Move Mouse To View CTRL + SHIFT + B

Move View To Mouse CTRL + SHIFT + Y

Tracking On/Off CTRL + ALT + SHIFT + T

Program Information CTRL + ALT + SHIFT + P

Mouse Hotkeys

Commands Keys

Character Prior NUMPAD 4

Character CTRL + INSERT + NUMPAD 5

Character Next NUMPAD 6

Word Prior INSERT + NUMPAD 4

Word INSERT + NUMPAD 5

Word Next INSERT + NUMPAD 6

Line Prior NUMPAD 8

Line WINDOWS + NUMPAD 5

Line Next NUMPAD 2

Clip Prior INSERT + NUMPAD 7

Clip INSERT + NUMPAD 8

Clip Next INSERT + NUMPAD 9
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Mouse Hotkeys (continued)
Single Click Left Button NUMPAD SLASH

Single Click Right Button NUMPAD STAR

Toggle Left Button INSERT + NUMPAD SLASH

Toggle Right Button INSERT + NUMPAD STAR

Top Left NUMPAD 7

Top Right NUMPAD 9

Bottom Left NUMPAD 1

Bottom Right NUMPAD 3

Mouse Up CTRL + SHIFT + NUMPAD 8

Mouse Down CTRL + SHIFT + NUMPAD 2

Mouse Left CTRL + SHIFT + NUMPAD 4

Mouse Right CTRL + SHIFT + NUMPAD 6

Position CTRL + INSERT + NUMPAD PLUS

Unicode/Attribute ALT + INSERT + F

Search CTRL + INSERT + F

Continue Search INSERT + F3

Continue Search Reverse SHIFT + INSERT + F3

Boundary Rotor INSERT + R

Drag and Drop INSERT + NUMPAD DELETE

Invisible/Mouse Toggle NUMPAD MINUS

Mouse to Focus INSERT + NUMPAD MINUS

Cursor to Mouse INSERT + NUMPAD PLUS
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Mouse Hotkeys (continued)

Sync Invisible and Mouse NUMPAD PLUS

Up Down Speak ALT + NUMPAD 5

Office Hotkeys

Commands Keys

Line Next ALT + .

Line Prior ALT + ,

Spelling/Grammar Next ALT + '

Spelling/Grammar Prior ALT + ;

Revision Next ALT + ]

Revision Prior ALT + [

Cell Right INSERT + RIGHT ARROW

Cell Left INSERT + LEFT ARROW

Cell Up INSERT + UP ARROW

Cell Down INSERT + DOWN ARROW

To First Cell of Row CTRL + INSERT + LEFT ARROW

To Last Cell of Row CTRL + INSERT + RIGHT ARROW

To First Cell of Column CTRL + INSERT + UP ARROW

To Last Cell of Column CTRL + INSERT + DOWN ARROW

To Top Left Cell INSERT + HOME

To Bottom Right Cell INSERT + END

Row SHIFT + INSERT + DOWN ARROW
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Office Hotkeys (continued)
From Row Start SHIFT + INSERT + LEFT ARROW

Row To End SHIFT + INSERT + RIGHT ARROW

First Row Cell SHIFT + INSERT + UP ARROW

Column ALT + INSERT + DOWN ARROW

From Column Start ALT + INSERT + LEFT ARROW

Column To End ALT + INSERT + RIGHT ARROW

First Column Cell ALT + INSERT + UP ARROW

Current Cell INSERT + NUMPAD ENTER

Element Properties INSERT + L

Page Navigation INSERT + F7

Headers and Totals ALT + SHIFT + H

Monitor Cells ALT + SHIFT + M

Monitor Cell 1 ALT + SHIFT + !

Monitor Cell 2 ALT + SHIFT + @

Monitor Cell 3 ALT + SHIFT + #

Monitor Cell 4 ALT + SHIFT + $

Monitor Cell 5 ALT + SHIFT + %

Monitor Cell 6 ALT + SHIFT + ^

Monitor Cell 7 ALT + SHIFT + &

Monitor Cell 8 ALT + SHIFT + *

Monitor Cell 9 ALT + SHIFT + (

Monitor Cell 10 ALT + SHIFT + )
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Office Hotkeys (continued)
Any Monitor Cell ALT + SHIFT + A

Read Total Cell ALT + SHIFT + O

Read Comment CTRL + ALT + C

Read Formula CTRL + ALT + O

Previous Cell ALT + SHIFT + P

Outlook Calendar INSERT + WINDOWS + C

Background Reader Hotkeys

Commands Keys

BGR Read Clipboard Text CAPS LOCK + C

BGR Read Selected Text CAPS LOCK + S

BGR Play / Pause CAPS LOCK + ENTER

BGR Restart
(from the beginning)

CAPS LOCK + BACKSPACE

BGR Next Sentence CAPS LOCK + RIGHT ARROW

BGR Current Sentence CAPS LOCK + SPACEBAR

BGR Previous Sentence CAPS LOCK + LEFT ARROW

BGR Next Word CTRL + CAPS LOCK + RIGHT ARROW

BGR Current Word CTRL + CAPS LOCK + SPACEBAR

BGR Previous Word CTRL + CAPS LOCK + LEFT ARROW

BGR Show Toolbar CAPS LOCK + T

BGR Exit CAPS LOCK + ESC
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Camera Hotkeys

Commands Keys

Camera Clarity On/Off ALT + WINDOWS + C

Camera Clarity Reset ALT + WINDOWS + R

Camera Manual Focus In CTRL + WINDOWS + RIGHT ARROW

Camera Manual Focus On/Off CTRL + WINDOWS + M

Camera Manual Focus Out CTRL + WINDOWS + LEFT ARROW

Camera On/Off CTRL + WINDOWS + ENTER

Camera Toolbar CTRL + WINDOWS + T

Camera Two-Color On/Off ALT + WINDOWS + SPACE

Camera Two-Color Scheme ALT + WINDOWS + S

Camera Zoom In CTRL + WINDOWS + UP ARROW

Camera Zoom Out CTRL + WINDOWS + DOWN ARROW

ImageReader Hotkeys

Commands Keys

ImageReader ALT + INSERT + I

Magnification Hotkeys

Commands Keys

Increase Magnification ALT + NUMPAD PLUS

Decrease Magnification ALT + NUMPAD MINUS



ZoomText Fusion 10.1 Quick Reference Guide 83

Magnifier Toolbar Hotkeys

Commands Keys

Cursor Enhancements On/Off CTRL + SHIFT + R

Desktop Finder CTRL + SHIFT + D

Focus Enhancements On/Off CTRL + SHIFT + O

Font Enhancements Type CTRL + SHIFT + F

Freeze Window On/Off CTRL + SHIFT + E

New Freeze Window CTRL + SHIFT + N

Pointer Enhancements On/Off CTRL + SHIFT + P

Smooth Panning On/Off ALT + SHIFT + P

Text Finder CTRL + SHIFT + T

View Mode On/Off CTRL + SHIFT + V

Web Finder CTRL + SHIFT + W

Window Type CTRL + SHIFT + Z

Miscellaneous Hotkeys

Commands Keys

Capture ZoomText Fusion Screen CTRL + ALT + SHIFT + C

Locator On/Off CTRL + SHIFT + L

Move Mouse To View CTRL + SHIFT + B

Move View To Mouse CTRL + SHIFT + Y

Tracking On/Off CTRL + ALT + SHIFT + T

Program Information CTRL + ALT + SHIFT + P
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Reader Toolbar Hotkeys

Commands Keys

AppReader ALT + SHIFT + A

AppReader from Pointer ALT + SHIFT + LEFT CLICK

DocReader ALT + SHIFT + D

Mouse Echo Mode ALT + SHIFT + M

Say Clipboard ALT + SHIFT + C

SpeakIt Tool ALT + SHIFT + I

Scroll Hotkeys

Commands Keys

Jump Center ALT + WINDOWS + NUMPAD 5

Jump Down ALT + WINDOWS + PAGE DOWN

Jump Left ALT + WINDOWS + HOME

Jump Right ALT + WINDOWS + END

Jump Up ALT + WINDOWS + PAGE UP

Restore View ALT + WINDOWS + NUMPAD STAR

Save View ALT + WINDOWS + NUMPAD SLASH

Scroll Down ALT + WINDOWS + DOWN ARROW

Scroll Left ALT + WINDOWS + LEFT ARROW

Scroll Right ALT + WINDOWS + RIGHT ARROW

Scroll Up ALT + WINDOWS + UP ARROW
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Reading Zones Hotkeys

Commands Keys

Edit Reading Zones CTRL + ALT + WINDOWS + E

List Reading Zones CTRL + ALT + WINDOWS + L

Navigate Reading Zones CTRL + ALT + WINDOWS + V

New Reading Zone CTRL + ALT + WINDOWS + Z

Next Reading Zone CTRL + ALT + WINDOWS + N

Previous Reading Zone CTRL + ALT + WINDOWS + P

Trigger Zone 1 CTRL + ALT + WINDOWS + 1

Trigger Zone 2 CTRL + ALT + WINDOWS + 2

Trigger Zone 3 CTRL + ALT + WINDOWS + 3

Trigger Zone 4 CTRL + ALT + WINDOWS + 4

Trigger Zone 5 CTRL + ALT + WINDOWS + 5

Trigger Zone 6 CTRL + ALT + WINDOWS + 6

Trigger Zone 7 CTRL + ALT + WINDOWS + 7

Trigger Zone 8 CTRL + ALT + WINDOWS + 8

Trigger Zone 9 CTRL + ALT + WINDOWS + 9

Trigger Zone 10 CTRL + ALT + WINDOWS + 0

User Interface Hotkeys
Commands Keys

Disable ZoomText Fusion ALT + DELETE

Enable ZoomText Fusion ALT + CAPS LOCK

User Interface CTRL + SHIFT + U
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Configuration Files

Note: Custom configurations are presently not supported in ZoomText Fusion.

All ZoomText Fusion settings can be saved and restored using configuration
files. Configuration files control all ZoomText Fusion features, including
magnification level, zoom window type, screen enhancements, reading options
and hotkeys. Any number of files can be saved, allowing you to create custom
ZoomText Fusion configurations that can be recalled at any time.

 To save settings to a configuration file

1. Set all ZoomText Fusion features as desired.
2. In the File menu, choose Save Configuration…

The Save Configuration dialog appears displaying the existing configuration
files.

3. Type the name of the new configuration in the File name box.
4. Click on the OK button.

 To load settings from a configuration file

1. In the File menu, choose Open Configuration…
The Open Configuration dialog appears displaying the existing
configuration files.

2. Highlight the desired configuration file.
3. Click on the Open button.
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The Default Configuration

When you start ZoomText Fusion, the default configuration file, ZT.ZXC, is
automatically loaded. This file contains the built-in defaults for all ZoomText
Fusion settings. You can create your own default configuration, which will load
your custom settings whenever ZoomText Fusion is run. Don't worry about
losing the built-in settings – the original default file can be easily restored.

 To save a custom default configuration

1. Set all ZoomText Fusion features as desired.
2. In the File menu, choose Save As Default.
3. Select Yes to overwrite the current default configuration.

 To restore the original default configuration file

1. In the File menu, choose Restore Default.
2. Select Yes to overwrite the current default configuration.
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Application Settings

Note: Application settings are presently not supported in ZoomText Fusion.

Within each ZoomText Fusion configuration, you can define unique settings for
each application that you use. For example, you can have ZoomText Fusion
display your web browser at one magnification level and your word processor
at another. When these applications become active, their application settings'
are automatically restored. Applications for which settings have not been
defined are displayed and spoken according to the default settings of the
configuration file.

 To define and save application settings

1. Open the application for which you want to define settings.
2. Switch directly to ZoomText Fusion and select the settings you wish to

use with that application.
3. In the File menu, choose Save Application Settings.

A dialog prompts you to save the application settings.
4. Click the Yes button to save the application settings.

At any time, you can disable or delete application settings. Disabled application
settings remain in your configuration and may be re-enabled at any time.
Deleted application settings are removed from your configuration.

 To disable or delete application settings

1. In the File menu, choose Manage Application Settings…
2. To disable application settings, uncheck the desired applications.
3. To delete application settings, select the desired application, then select

Delete Selected.
4. Click on the OK button.
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ZoomText Fusion Scripting

ZoomText Fusion’s scripting feature allows you to customize the behavior of
ZoomText Fusion and other applications, providing more informative visual
and audible feedback, as well as automation of tasks. Scripting allows you to
work with improved speed and efficiency.

Some of the many things you can do with ZoomText Fusion scripting are:
automatically announce fields in a database or spreadsheet, new email items,
new text that arrives in a chat window, and more meaningful descriptions of
application controls and data.

To learn more about ZoomText Fusion Scripting, see the “Scripting” section in
the ZoomText Fusion online help system. To open ZoomText Fusion’s online
help, in the Help menu, choose ZoomText Help.
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